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Copyrights

The Motorola products described in this document may include copyrighted Motorola computer programs stored in 
semiconductor memories or other media.

Laws in the United States and other countries preserve for Motorola certain exclusive rights for copyright computer 
programs, including the exclusive right to copy or reproduce in any form the copyright computer program. 
Accordingly, any copyright Motorola computer programs contained in the Motorola products described in this 
document may not be copied or reproduced in any manner without the express written permission of Motorola. 
Furthermore, the purchase of Motorola products shall not be deemed to grant either directly or by implication, 
estoppel or otherwise, any license under the copyrights, patents or patent applications of Motorola, except for the 
rights that arise by operation of law in the sale of a product.

Confidentiality

You acknowledge and agree that the Software, including its structure, organization, design, and Documentation, 
contains and constitutes proprietary trade secrets and confidential information of Motorola Solutions (the 
“Confidential Information”). You agree to take all steps reasonably necessary to maintain and protect the 
Confidential Information in the strictest confidence for the benefit of Motorola Solutions, including by instruction 
to or agreement with all persons authorized to have access to the Documentation under this Agreement. 

Restrictions

The software described in this document is the property of Motorola. It is furnished under a license agreement and 
may be used and/or disclosed only in accordance with the terms of the agreement. Software and documentation are 
copyright materials. Making unauthorized copies is prohibited by law. No part of the software or documentation 
may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or 
computer language, in any form or by any means, without prior written permission of Motorola.

Accuracy

While reasonable efforts have been made to assure the accuracy of this document, Motorola assumes no liability 
resulting from any inaccuracies or omissions in this document, or from the use of the information obtained herein. 
Motorola reserves the right to make changes to any products described herein to improve reliability, function, or 
design, and reserves the right to revise this document and to make changes from time to time in content hereof with 
no obligation to notify any person of revisions or changes. Motorola does not assume any liability arising out of the 
application or use of any product or circuit described herein; neither does it convey license under its patent rights of 
others.

Trademarks

Motorola, Moto, Motorola Solutions, PremierOne, and the stylized M logo are trademarks or registered trademarks 
of Motorola Trademark Holdings, LLC and are used under license.

Microsoft, Windows, Windows XP, Windows Vista, Windows 7, and Windows Server are registered trademarks of 
Microsoft Corporation. All other product or service names are the property of their respective owners.

Build date: August 30, 2013
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CHAPTER

1

. . . 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Introduction 1

PREMIER TDD provides a way for dispatchers to communicate with callers who use a 
TDD (Telecommunication Device for the Deaf). This document is intended for 
personnel responsible for handling incoming 911 calls and supports PREMIER TDD 
Version 3.2.

PREMIER TDD can be used in conjunction with Zetron 3030F, Zetron 3030, and 
MAARS modules Answering Position Units. This manual does not contain instructions 
relating to the installation or functions of the equipment. Refer to the respective 
manuals for this information.

This guide describes how to configure PREMIER TDD and use the PREMIER TDD 
Call dialog box to communicate with callers. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Using the Documentation

This user guide contains the following chapters:

Chapter 1: “Introduction.”
Contains general information about this User Guide and how to report problems that 
are experienced with PREMIER TDD.

Chapter 2: “Configuring PREMIER TDD.”
Contains instructions about how to configure TDD, including hardware setup, system 
parameters, message configuration, and PSAP configuration. 

Chapter 3: “Communicating With a Caller Using Premier TDD.”
Contains a description of the PREMIER TDD Call dialog box functions, and how to 
interrogate an open line and receive a call without interrogation. TDD 
recommendations, codes, and call logging are also described.
September 2013 1-1
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Technical Support Chapter 1: Introduction
Conventions Used in This Guide

Note the following conventions used in this guide:

 Labeled buttons, commands, and options are in bold. 
For example, click OK to close the dialog box.

 Information that the user needs to enter is in Courier New font.
For example, type BO90001 in the text box.

 File names are in Courier New font.
For example, locate the file Motorola\TDD\TDD.exe.

Notes and Cautions

Throughout this guide, notes and cautions are used to highlight text. Notes indicate 
information that is of high importance. Cautions contain information that must be 
observed or damage to the system could result. 

NOTE
Information listed in notes is of high importance.

CAUTION
Cautions contain information that must be observed or loss of data could result.

Displaying Version Information

To display PREMIER TDD version information:

From the Help menu, select About.

The About TDD dialog box appears showing the version of TDD.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Technical Support

You can obtain support by phone from Technical Support at 1-800-323-9949. 
International customers, please call 1-847-576-7300. After you are connected, use the 
following information to obtain product-specific support.
1-2 September 2013
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 For CAD, press 2-6-1

 For RMS, press 2-6-2

 For Mobile, press 2-6-3

 For Jail, press 2-6-4

 For all other products, press 2-6-0

During regular business hours, your call is routed directly to available technical 
support personnel. After regular business hours, a 24/7 support engineer is contacted 
and will immediately return your call. Have the following information ready:

 Product name and version number

 Description of the problem 

 What you were doing when the problem occurred

 Steps you took to try to solve the problem

 Hardware description

 Exact wording of any messages appearing on your screen
September 2013 1-3
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CHAPTER

2

. . . 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Configuring PREMIER TDD 2

This chapter describes how to configure PREMIER TDD. Provisioning, configuration, 
security, setting up the hardware, setting system parameters, configuring messages, and 
setting up secondary Public Safety Answering Points (PSAPs) are detailed.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Provisioning

Before using TDD, you must set TDD up in Provisioning.

To set up TDD in Provisioning:

1. Access Provisioning.

2. From the navigation pane, select Resources, then select Systems, and then select 
TDD.

3. From the Systems-TDD filter page, select Add New and select the Agency that will 
be using TDD. Click OK.
September 2013 2-1
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Provisioning Chapter 2: Configuring PREMIER TDD
The Systems-TDD form appears.

4. In the Name field, type a name for the TDD system.

5. In the Description field, type a description for the TDD system.

6. Click Save.

Figure 2-1 Systems-TDD Form
2-2 September 2013
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After you save the file, a 36-digit ID appears in the ID field.

7. From the Navigation pane, select Resources, then select Devices, and then select 
Workstation/MDT.

8. From the Workstation/MDT filter page, select Add New and select the Agency that 
will be using TDD. Click OK.

The Devices form appears.

9. From the Device Type list, select Workstation.

10. In the Device ID field, type an ID for the device, such as TDD_Device.

11. Select the check box for the TDDWorkstation field.

12. In the Position field, type the numeral 1. 

This is for phone position 1.

The rest of the fields are optional for TDD.

13. Click Save.

Figure 2-2 Systems-TDD Form Showing ID
September 2013 2-3
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Configuration

After setting up TDD in Provisioning, you must set it up in int System Management 
Portal Configuration Module.

To set up TDD in the System Management Tool Portal Configuration module:

1. Access the Configuration module from the System Management Tool Portal. If you 
are already in Provisioning, you can go to the View menu and select Web Portal.

2. Select the Edit tab.

Figure 2-3 System Management Tool Portal – Configuration Module
2-4 September 2013
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3. In the pane on the left, scroll down until you can select 
Tdd\TddInterface_confix.xml.

4. For the DeviceConfiguration element, set the values of the following attributes:

 Set the value of the Configuration attribute to “TDD”.

 Set the value of the ID attribute to the name of the TDD system.

 For the value of the ResourceAssemblyKey attribute, copy the 36-digit ID 
code from the Systems-TDD screen in Provisioning. (See “Provisioning” on 
page 2-1, specifically step 6.)

5. For the Host element, set the values of the following attributes:

 Set the value of the ID attribute to the address of the TDD system (based on the 
customer environment).

 Set the value of the PrimaryPort attribute to “9000”.

6. Click Save.

Figure 2-4 TddInterface_Config.xml
September 2013 2-5
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Security

Changes made to PREMIER TDD that affect the TDD.INI file are password 
protected. When you change any configuration parameters, the Master Password 
dialog box appears prompting you for your password. The password is initially set by 
Motorola and can be changed by authorized personnel. Contact Motorola for password 
information.

To change configuration items:

1. Open the configuration dialog box.

2. Make your changes and click OK.

The Master Password dialog box appears.

3. Type the master password and click OK.

If you do not have the correct password, the new settings are not saved.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Setting up the System Hardware

The hardware you select determines the other commands that are available for 
additional system configuration. PREMIER TDD supports the following hardware 
devices: MAARS, Zetron 3030, and Zetron 3030F. 

To set up system hardware:

1. From the Configure menu, select System Hardware.

Figure 2-1  Master Password Dialog Box
2-6 September 2013
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The Configure System Hardware dialog box appears.

2. From the PSAP (Public Safety Answering Point) Hardware drop-down list, select 
the type of hardware that is installed.

Options include the following:

 MAARS – interprets baudot data generated from a standard TDD. Baudot is a 
transmission code that uses five bits per character, thus allowing up to 32 
distinct characters.

 Zetron 3030 – interprets baudot and ASCII data. ASCII data is generated from a 
TDD application on a PC. 

 Zetron 3030F – interprets baudot data and ASCII data. 

Zetron 3030F allows the forwarding of the TDD call with existing dialogue to 
another agency also using a Zetron 3030 or 3030F.

NOTENOTE
Zetron 3030 hardware can accept a forwarded call, but cannot forward a call.

3. From the Com Port drop-down list, select the communication port.

4. From the Baud Rate drop-down list, select the transmission rate.

This is for MAARS configuration only. This entry does not refer to the baud rate of 
the TDD signal sent to the caller.

5. From the Parity drop-down list, select the data transmission type between the 
installed hardware and the dispatcher’s workstation.

This is for the MAARS configuration only. 

6. Leave the Data Bits set to 8.

Figure 2-1  Configure System Hardware Dialog Box
September 2013 2-7
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7. Leave the Stop Bits set to 1.

8. To allow toggling between voice and typing, select the Allow HCO/VCO (Hearing 
Carry Over/Voice Carry Over) check box.

When this check box is selected, the dispatcher can toggle between voice mode and 
typing mode by pressing Alt+V. This is useful for a caller who can speak but cannot 
hear.

If this check box is not selected, the dispatcher can only communicate by typing.

9. Click OK.

The Master Password dialog box appears.

10. Type the master password and click OK.

For additional details about security, see “Security” on page 2-6.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Setting System Parameters

System parameters include the default language of the site-specific messages and 
corresponding function keys, how the question mark ( ? ) is translated in the caller’s 
TDD, logging details for the transcript of the TDD call, and CAD identifier and 
parameter delimeters. 
2-8 September 2013
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To set up system parameters:

1. From the Configure menu, select System Setup.

The System Setup dialog box appears.

2. From the Default Language drop-down list, select the language used for the site-
specific messages and corresponding function keys.

To add a new language, click the Languages button. For details, see “Adding and 
Editing Languages” on page 2-11.

3. In the Translate “?” text box, type a string of text that is sent to the caller’s TDD 
whenever the dispatcher enters a question mark.

For example, the following TDD convention could be entered:

Are you alright QQ

With this setting, the QQ is used in place of a question mark. 

4. In the Interrogation Message text box, type the message that is automatically sent 
across the line when a line is interrogated for a possible TDD call. 

For PREMIER TDD to make a connection, the caller must type something after the 
line is interrogated. The interrogation message must identify the agency and 
instruct the caller to begin typing.

Figure 2-1  System Setup Dialog Box
September 2013 2-9
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5. Select the Send Interrogation Message check box.

6. To use Baudot forwarding of calls, select the Allow BAUDOT Forwarding check box.

If Baudot forwarding is selected, both ASCII and Baudot calls are accessible. If 
Baudot forwarding is not selected, only ASCII calls are accessible. 

Baudot is a transmission code that uses five bits per character. 

7. To store a transcript of the TDD call locally, select the Use Local Log File check 
box.

When the TDD Call window closes, the communication between the TDD caller 
and the dispatcher is appended to the TDD.LOG file. For additional details on log 
files, see “Local Logging” on page 3-9.

8. In the Local Log File path text box, type the location where you want the log file 
stored.

9. To store the transcript of the TDD call in PREMIER CAD, select the Use CAD 
Logging check box.

The transcript is stored with either the incident that is associated with the TDD call, 
or the incident type that is defined in the Incident Type field.

For additional details on CAD log files, see “CAD Logging” on page 3-9.

10. To receive a message indicating an incomplete transmission when you close the 
TDD Call dialog box, select the Warn on incomplete transmit at close check box.

11. From the CAD Identifier Delimiter drop-down list, select the CAD delimiter.

The delimiter is used to separate command identifiers and is site-specific. Options 
include a semicolon (;) or an equal (=) sign.

For example: 
IR.<incident number>.DR;Y or IR <incident number> DR=Y.

12. From the CAD Parameter Delimiter drop-down list, select the CAD parameter 
delimiter.

The delimiter is used to separate command parameters on the command line and is 
site-specific. Options include a period or a space.

For example: 
IR.<incident number>.DR;Y or IR <incident number> DR=Y.

13. Click OK.

The Master Password dialog box appears.

14. Type the master password and click OK.

For additional details about security, see “Security” on page 2-6.
2-10 September 2013
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Managing Languages

You can add, edit, and delete languages in PREMIER TDD. You select the language to 
be used in the System Setup dialog box.

Adding and Editing Languages

To addor edit a language:

1. From the Configure menu, select System Setup.

The System Setup dialog box appears.

2. Click the Languages button. 

The Configure Languages dialog box appears.

3. Click the New button.

The Edit Language dialog box appears.

4. In the Language text box, type the name of the language.

5. Click OK.

Figure 2-1  Configure Languages Dialog Box

Figure 2-1  Edit Language Dialog Box
September 2013 2-11
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Deleting Languages

To delete a language:

1. From the Configure menu, select System Setup.

The System Setup dialog box appears.

2. Click the Languages button. 

The Configure Languages dialog box appears.

3. Select the language you want to delete and click Delete.

4. Click OK to close the Configure Languages dialog box.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Configuring Messages

Message configuration allows you to configure the function keys that display in the 
TDD Call dialog box and the site-specific messages that are transmitted. 

To configure messages:

1. From the Configure menu, select Messages.
2-12 September 2013
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The Configure User Messages dialog box appears. The Key column lists the 
function keys that can have a message attached. When a function key on the 
keyboard is pressed, the corresponding text is automatically sent to the caller’s 
TDD.

2. From the Language drop-down list, select the language that is used to create the 
site-specific messages.

For details on setting up languages, see “Managing Languages” on page 2-11.

NOTENOTE
Make sure the language is selected before entering the message in the Text 
boxes. If a language is selected after text is entered, the existing text clears from 
the Text boxes.

3. In the Text boxes, type the text of the message for each corresponding function key.

4. In the Label boxes, type a label identifying the text message type for each function 
key.

For example, the text What is your address? could have the label Addr? 

5. To configure an additional language, repeat <z blue>step 2 to <z blue>step 4.

6. Click OK.

The Master Password dialog box appears.

7. Type the master password and click OK.

For additional details about security, see “Security” on page 2-6.

Figure 2-1  Configure User Messages Dialog Box
September 2013 2-13
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Configuring Secondary PSAPS

If you are using Zetron 3030F hardware, you can configure secondary PSAPs (Public 
Safety Answering Points) to which a TDD call can be forwarded, such as another 
agency or dispatcher. The secondary PSAPs must also have a Zetron 3030 or 3030F 
installed. The Zetron 3030 hardware can only receive a forwarded call from a Zetron 
3030F. Only calls that are received as ASCII can be forwarded.

Once received, the call cannot be forwarded. 

CAUTION
The Zetron 3030F hardware does not release the dispatcher who forwarded the call. 
Instead, the TDD caller, original dispatcher, and secondary PSAP are linked. 
PREMIER TDD allows both dispatchers to communicate with the TDD caller.

If the original dispatcher should disconnect from the call, the connection between the 
TDD caller and the secondary PSAP is lost.

To configure secondary PSAPs:

1. From the Configure menu, select Secondary PSAPS.

The Secondary PSAPs dialog box appears. The Key column lists the function keys 
that can have a secondary PSAP attached. Pressing the Shift+function key on the 
keyboard forwards the call.

2. In the Name box, type the full name of the secondary PSAP for each of the 
corresponding function keys.

Figure 2-1  Configure Secondary PSAP Names Dialog Box
2-14 September 2013
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3. In the Label box, type a label that easily identifies the corresponding full-length 
PSAP name for each corresponding function key. 

For example, the Name High Country Fire could have the label HighFire. 

4. Click OK.

The Master Password dialog box appears.

5. Type the master password and click OK.

For additional details about security, see “Security” on page 2-6.
September 2013 2-15
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CHAPTER

3

Communicating With a Caller 

. . . 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Using Premier TDD 3

This chapter presents an overview of the functionality of the TDD Call dialog box and 
describes how to interrogate an open line and receive a TDD call without interrogation. 
TDD call logging is also described.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Overview of the TDD Call Dialog Box

The TDD Call dialog box is used to communicate with a TDD caller. The caller’s 
communication displays in the C<A>ller’s Text box. You use a combination of the site-
specific function keys, the Caller’s text, and text typed into the <O>utgoing box to 
communicate with the caller.

Figure 3-1 TDD Call Dialog Box

Status Line
September 2013 3-1
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The TDD Call dialog box contains the following sections:

 Status Line. The Status line displays the status information about the current TDD 
operations. The left side of the status line displays status messages about current 
TDD connections and errors. The right side of the status line indicates the type of 
data (ASCII or Baudot) that is being received for the current TDD call.

 Function Keys. When pressed, the function keys display the site-specific message 
functions. The function keys show only the labels for the configured messages. 
When a specific function key is pressed, the corresponding message text is 
automatically sent to the caller’s TDD. For details on message configuration, see 
“Configuring Messages” on page 2-12).

 Shift+Function Keys. When pressed, the Shift+function key combination displays 
the secondary PSAP functions that are currently configured. The secondary PSAP 
function keys only contain the labels for configured secondary PSAPs. When the 
Shift+function key is pressed from a Zetron 3030F, the current TDD call and 
existing communication is forwarded to the selected PSAP. For details on PSAP 
configuration, see “Configuring Secondary PSAPS” on page 2-14.

NOTENOTE
Forwarding a call to a secondary PSAP is available only if Zetron 3030F hardware 
is installed in the current PREMIER CAD system, and an ASCII connection is 
established. Any calls that are not ASCII (such as Baudot) cannot be forwarded.

 <L>anguage. This box displays the language used to format the function key labels 
and the corresponding site-specific messages. You can select a different language 
from the drop-down list. For details on configuring languages, see “Setting System 
Parameters” on page 2-8.

 Outgoing Text box. This box contains the cumulative text that you type to 
communicate with the TDD caller. Text is immediately transmitted to the caller. 

Type each message in the blue text box below the Outgoing text box. Text displays 
in the Outgoing text box in blue and in lower case. 

If the current call is forwarded to a secondary PSAP, the <O>utgoing Text label 
changes to Secondary PSAP Text. The secondary PSAP’s communication displays 
in the window. However, the first PSAP dispatcher (who forwarded the call) is not 
released from the call. Instead, the TDD caller, original dispatcher, and secondary 
PSAP are able to communicate with the TDD caller.

If the cursor is not at the end of the line when typing resumes, PREMIER TDD 
generates a warning sound, moves the cursor to the end of the text, and shows the 
typed character at the new cursor location.

NOTE
The Alt+O key combination can be used to move the cursor to the Outgoing Text box.
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 C<A>ller’s Text. This box displays the text from the TDD caller as each character 
is received. The text displays in red and in upper case. 

NOTENOTE
The Alt+A key combination can be used to move the cursor to the C<A>ller’s Text 
box. To scroll through the caller’s text, use the arrow keys.

 Co<M>plete Dialogue. This box displays the text of the dialogue that occurs 
between the call taker or dispatcher, the secondary PSAP dispatcher (if any), and 
the TDD caller as the text is received or transmitted. The transcript created from the 
dialogue contains various system messages, which are enclosed in brackets. Each 
system message is followed by a timestamp.

NOTENOTE
The Alt–M key combination can be used to move the cursor to the Co<M>plete 
Dialogue box.

 Send to CAD button. Click this button to send a copy of the dialogue to 
PREMIER CAD. For additional details, see “Interrogating an Open Line” on 
page 3-5.

 Reinterrogate button. Click this button to interrogate an open line a second time if a 
reply is not received after sending the initial interrogation message.

If a connection is not made after a site-specific delay, the following message 
displays in the Co<M>plete Dialogue box:

<10 seconds No Reply> <Disconnected> 

In Zetron systems, the status line of the TDD Call dialog box additionally displays 
Interrogation Timeout. If this message displays, click the Close button to 
terminate the call.

 Terminate/Close/Disconnect. The following labels can display on this button:

Terminate. Displays if an active TDD call has just taken place. Click this button to 
end the connection, append the text in the Complete Dialogue box to the TDD.LOG 
file, and disconnect the TDD Call dialog box.

Close. Displays if an open line did not connect to a TDD caller. Click this button to 
close the TDD Call dialog box.

Disconnect. Displays if the current call was forwarded to a secondary
PSAP. Click this button to disconnect the TDD call.
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For details on configuring the TDD.LOG, see “Setting System Parameters” on 
page 2-8.

CAUTION
If the original dispatcher clicks the Disconnect button, the connection between the 
TDD caller and the secondary PSAP is lost.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
TDD Recommendations

Because of the limitations of the average TDD device, keep in mind the following 
conventions and recommendations when communicating with a TDD caller:

 Begin each transmission with at least two blank spaces to separate your message 
from the caller's message in the caller's TDD display.

 End each transmission with a carriage return after the GA code (see following table 
for a description of codes).

 Keep messages short. Most TDD devices use a dot-matrix display that is capable of 
showing only 20 characters at a time. Even though the speed of TDD 
communications is relatively slow (about five characters per second), text sent at 
maximum speed can still scroll by faster than the caller can read it. 

 Avoid use of punctuation. Most TDD keyboards differ from standard typewriter or 
computer keyboards. Generally, a TDD device has only three rows of keys. 
Punctuation (except for the period and comma) and numbers are created by using 
the Shift key and a designated letter of the keyboard. Because many callers use 
their TDD devices infrequently, they tend not to use punctuation.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

TDD Codes

The following table lists standard TDD codes that are used to indicate when a person is 
finished sending a message and the other person can reply; how to replace punctuation; 
and how distinguish the end of the telephone conversation.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Interrogating an Open Line

To interrogate an open line: 

1. Display the PREMIER TDD main window.

2. Do one of the following:

 For Zetron hardware, from the File menu, select the Interrogate command. 

 On the MAARS console, press the TDD Function key twice.

The interrogation message that is currently configured is transmitted to the caller’s 
TDD. This message displays in the Complete Dialogue box.

NOTENOTE
An interrogation timeout occurs in about twenty seconds; until then, 
PREMIER TDD disables the Reinterrogate and Close buttons.

If a response is not received:

a. Interrogate the line again by clicking the Reinterrogate button or by using the 
Alt+R key combination. 

Table 3-1  TDD Codes and Meanings

TDD Code Meaning

GA Use to signal Go Ahead to mark the end of your message and that the other person 
may respond. For example:

IS EVERYONE OK? GA

QQ Use to replace a question mark (?), which some TDDs do not have. The GA code 
must still be typed at the end of the transmission. For example:

IS EVERYONE OK QQ GA

GA SK
GA/SK
GA or SK

Use to signal intent to sign off (such as “This ends my side of the conversation. Do 
you have something else to add?”). For example:

A POLICEMAN IS ON THE WAY. GA/SK

SK SK
SK/SK

Use to acknowledge the other person’s GA/SK and to terminate the conversation 
on both sides. For example:

THANK YOU. I'LL WAIT OUTSIDE. SK/SK
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The interrogation message is resent. The Zetron or MAARS waits a configured 
amount of time, and sends a disconnect message if no transmission is received.

If a response is received, the Caller’s Text box of the TDD Call dialog box 
displays the caller’s reply and a Connected message displays in the Complete 
Dialogue box.

b. Click Close to minimize the TDD Call dialog box and return focus to 
PREMIER CAD.

Receiving a TDD Call Without 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Interrogation

If a TDD caller begins typing before an interrogation message has been sent, the TDD 
Call dialog box immediately displays on top of the PREMIER CAD window. If the call 
taker is initiating an incident for another call, the call taker may need to use the 
Alt+Tab key combination to return to PREMIER CAD to complete the task. 

Before returning to PREMIER CAD, however, the call taker should use the appropriate 
TDD function key to send a predefined message to the TDD caller. This action assures 
the TDD caller that a connection has been made. If the TDD Call dialog box is 
positioned so that the Complete Dialogue box remains visible when placed behind 
PREMIER CAD, the call taker can monitor the incoming text.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Sending the Dialogue to PREMIER CAD

You can send a copy of the complete dialogue in the TDD Call dialog box to the 
incident in PREMIER CAD.

To send the dialogue to PREMIER CAD:

1. From the TDD Call dialog box, click the Send to CAD button.

The CAD Logging dialog box appears.

2. In the CAD Incident Number text box, type the incident number to which you want 
the conversation transmitted.

The usual configuration rules apply with regard to the incident number; you may 
need to specify an agency ID or # depending on the configuration for the site. If the 
incident is active, you can substitute a unit ID.

3. To include associated incidents, select the Include Associated Incidents check 
box.

4. Click the Send button.

Figure 3-1  CAD Logging Dialog Box
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The conversation is transmitted to PREMIER CAD. The progress of the 
transmission displays in the CAD Logging dialog box. The Message <TDD 
Conversation Sent to this Point> displays in the Co<M>plete Dialogue box to 
indicate how much information has been transmitted.

Each line of code is transmitted as an individual record. Operator-initiated 
messages begin with O-, System messages begin with S-, and Caller messages 
begin with C-. If PREMIER CAD cannot identify the source (such as a carriage 
return or line feed) the message is indicated by ?-.

5. Repeat <z blue>step 1 through <z blue>step 4 as many times as needed.

You can send pieces of the conversation sequentially. This might be useful when 
you want to send the initial details to PREMIER CAD for dispatching and then 
later want to send any updates.

If you select Warn on incomplete transmit on close in the configuration settings 
and then close the TDD Call dialog box without transmitting all of the 
conversation, the Warning dialog box appears. For details on the configuration 
settings, see “Setting System Parameters” on page 2-8

.

Click No to return to the TDD Call dialog box and finish sending the CAD 
information.

Figure 3-1  Co<m>plete Dialogue Box Displaying Transmission Messages

Figure 3-1  Warning Dialog Box
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TDD Call Logging

PREMIER TDD provides two methods for logging the TDD dialogue transcript:

 Use Local Log File

 Use CAD Logging

To enable logging, see “Setting System Parameters” on page 2-8.

Local Logging 

For local logging, the complete transcript created from the TDD call is logged to 
TDD.LOG. Closing the TDD Call dialog box appends the dialogue of the TDD caller 
and the primary dispatcher and secondary dispatcher (if any) to the log file. The 
transcript is the text that is displayed in the Complete Dialogue box of the TDD Call 
dialog box.

The TDD.LOG file is identified by a filename that indicates the date in YYMDD 
format; M is in hexadecimal format where 0=January. An example file name is 
TDD10A04.LOG). Each new transcript that is appended to the file is identified with 
the message TDD Call Begin, and the end of the transcript is identified by the 
message TDD Call End. 

CAD Logging

For CAD Logging, the TDD call transcript is stored in PREMIER CAD as a comment 
field for the corresponding incident record. 

********** TDD Call Begin **********

<Interrogating...>
<2010/10/17 08:52:02.580>
911, can I help you qq  ga
<10 Seconds- No Reply>
<Disconnected>
<2010/10/17 08:52:12.030>

*********** TDD CALL END ***********

Figure 3-2 Sample Transcript in the TDD.LOG File
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